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SHORT ABSTRACT: 
The precise localization of Golgi residents is essential for understanding the cellular 
functions of the Golgi. However, conventional optical microscopy is unable to resolve 
the sub-Golgi structure. Here we describe the protocol for a conventional microscopy 
based super-resolution method to quantitatively determine the sub-Golgi localization of 
a protein. 
 
LONG ABSTRACT: 
The Golgi complex consists of serially stacked membrane cisternae which can be 
further categorized into sub-Golgi regions, including the cis-Golgi, medial-Golgi, trans-
Golgi and trans-Golgi network. Cellular functions of the Golgi are determined by the 
characteristic distribution of its resident proteins. The spatial resolution of conventional 
light microscopy is too low to resolve sub-Golgi structure or cisternae. Thus, the 
immuno-gold electron microscopy is a method of choice to localize a protein at the sub-
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Golgi level. However, the technique and instrument are beyond the capability of most 
cell biology labs. We describe here our recently developed super-resolution method 
called Golgi protein localization by imaging centers of mass (GLIM) to systematically 
and quantitatively localize a Golgi protein. GLIM is based on standard fluorescence 
labeling protocols and conventional wide-field or confocal microscopes. It involves the 
calibration of chromatic-shift aberration of the microscopic system, the image acquisition 
and the post-acquisition analysis. The sub-Golgi localization of a test protein is 
quantitatively expressed as the localization quotient. There are four main advantages of 
GLIM; it is rapid, based on conventional methods and tools, the localization result is 
quantitative, and it affords ~ 30 nm practical resolution along the Golgi axis. Here we 
describe the detailed protocol of GLIM to localize a test Golgi protein. 
 
INTRODUCTION: 
The Golgi complex plays essential roles in secretory/endocytic trafficking of proteins 
and lipids (hereafter cargos) in mammalian cells1-3. At the Golgi, cargos are not only 
sorted to various sub-cellular compartments but also modified by diverse types of 
glycosylation. The mammalian Golgi complex comprises numerous laterally connected 
Golgi stacks, which typically consists of 4–11 tightly adjacent and flat membrane sacs 
called cisternae. The serially stacked Golgi cisternae are further categorized, from one 
end to the other, as cis, medial and trans-cisternae. At the trans-side of a Golgi stack, 
the trans-most membrane sac develops into a tubular and reticulum membrane network 
called the trans-Golgi network (TGN)4. In the secretory pathway, cargos derived from 
the endoplasmic reticulum (ER) enter a Golgi stack at its cis-side and then sequentially 
pass through medial and trans-cisternae. Cargos eventually exit the Golgi at the trans-
Golgi or TGN destining to the plasma membrane, endosomes or secretory granules. 
 
The molecular and cellular mechanisms of how cargos transit a Golgi stack and how the 
Golgi maintains its cisternal organization remain mysterious and are currently still under 
a heated debate1. One of difficulties in this field is that Golgi cisternae can only be 
resolved under the electron microscopy (EM) since the resolution of an optical 
microscope (~ 200 nm) is insufficient to resolve individual Golgi cisternae (< 100 nm in 
both cisternal thickness and distance). Therefore, the sub-Golgi localization of resident 
proteins and transiting cargos are conventionally determined by the immuno-gold EM. 
However, the immuno-gold EM is very technically demanding and it is beyond the 
capability of most cell biology labs. Although the resolution of the EM can be sub-
nanometer, the resolution afforded by the immuno-gold EM is greatly hampered by the 
size of the antibody complex (primary plus the secondary antibody) and the gold particle, 
and it can be worse than 20 nm. Furthermore, EM images are obtained from 2D thin-
sections instead of a 3D global view of the Golgi, which can result in erroneous 
conclusions depending on the relative position and orientation of the 2D section5. For 
example, studying an EM single-section is unable to reliably differentiate a vesicle from 
the orthogonal view of a tubule since both can display identical round membrane 
profiles. The recent advent of super-resolution microscopy techniques, such as 3D-
structured illumination microscopy (3D-SIM), stimulated emission depletion (STED), 
photoactivated localization microscopy (PALM) and stochastic optical reconstruction 
microscopy (STORM), makes it possible to resolve sub-Golgi structures under light 



microscopes6. However, there are at least four drawbacks that can significantly limit 
their uses in the cell biological study of the Golgi. 1) Current super-resolution techniques 
require expensive and special hardware configuration which is beyond most cell biology 
labs. 2) Special fluorescence labeling protocols are needed for some super-resolution 
techniques. 3) Although, under the best condition, these techniques claim 20–110 nm in 
spatial resolution, the practical resolution obtained in real samples can be much worse. 
4) In comparison to conventional microscopy, these super-resolution techniques still 
have difficulties in conducting multicolor, 3D or live cell imaging, either singly or in 
combination. Probably most importantly, both immuno-gold EM and the super-resolution 
microscopy techniques yield qualitative instead of quantitative localization data. 
 
Attempting to partially solve problems mentioned above, we have recently developed a 
conventional light microscopy based method, which is named Golgi protein localization 
by imaging centers of mass (GLIM), to systematically and quantitatively localize a Golgi 
protein at a resolution equivalent to that of the immuno-gold EM7. In this method, the 
Golgi in cultured mammalian cells is dispersed as Golgi mini-stacks by the treatment of 
nocodazole, a microtubule depolymerizing drug. Extensive studies have demonstrated 
that nocodazole-induced Golgi mini-stacks (hereafter Golgi mini-stacks) closely 
resemble native Golgi stacks in both organization and cellular functions8-11. The 
localization quotient (LQ) of a test protein can be acquired through GLIM and it denotes 
the quantitative sub-Golgi localization. The numerical values of LQs can be compared 
and a LQ database of more than 25 Golgi markers has been available. 
 
In GLIM, Golgi mini-stacks are triple-labeled by endogenous or exogenously expressed 
GM130, GalT-mCherry and the test protein (x). GM130 and GalT-mCherry, cis- and 
trans-Golgi markers respectively12,13, provide reference points. The triple fluorescence, 
red (R), green (G) and far-red (B), are artificially displayed as red, green and blue, 
respectively. Center of fluorescence mass (hereafter center) is adopted to achieve sub-
pixel resolution. The Golgi axis is defined as the vector from the center of GM130 to that 
of GalT-mCherry. The Golgi mini-stack is modeled as a cylindrical structure with infinite 
rotational symmetry around the Golgi axis. Therefore, a Golgi mini-stack can be further 
modeled as an one-dimensional structure along the Golgi axis. The LQ of the test 
protein x is defined as dx/d1, in which dx is the distance from the center of x to that of 
GM130, while d1 is the distance from the center of GalT-mCherry to that of GM130. If 
the center of x is off-axis, its projection axial distance is used for the calculation. The 
variables, including Golgi axis, axial angle, dx, d1, angle α and angle β, for GLIM are 
schematically illustrated in Figure 1. LQ is independent of the Golgi axial angle though 
Golgi mini-stacks orient randomly in a cell. 
 
Golgi mini-stacks appear inhomogeneous in images. We developed three criteria to 
select analyzable Golgi mini-stacks for GLIM. 1) The signal-to-noise ratio criterion, in 
which the ratio of the total intensity of a Golgi mini-stack to the standard deviation (SD) 
of the background is ≥ 30 in each channel. This criterion is to ensure the positioning 
accuracy of the center of mass, which depends on the signal-to-noise ratios of Golgi 
mini-stacks. 2) The axial angle or distance criterion, which requires d1 ≥ 70 nm. d1 
decreases with the increase of the Golgi axial angle. When the axial angle is 



approaching 90° or vertical, the mini-stack becomes non-resolvable as d1 is 
approaching 0. d1 ≥ 70 nm can effectively exclude near vertical Golgi mini-stacks. 3) 
The co-linearity criterion, in which either |tan α| or |tan β| is ≤ 0.3. This criterion ensures 
that the three centers of a mini-stack are sufficiently co-linear for our one-dimensional 
model of the Golgi mini-stack. All light microscopes suffer from chromatic aberration 
which can seriously distort the relative positions of red, green and far-red fluorescence 
centers. Chromatic aberration of microscope systems is experimentally calibrated by 
imaging 110 nm beads, which are triple-labeled by red, green and far-red fluorescence. 
For each bead image, the center of red is defined as the true position of the bead and 
chromatic-shifts of green and far-red centers are fitted by first-order polynomial 
functions. Centers of Golgi mini-stacks are subjected to the polynomial functions to 
correct the chromatic-shifts in green and far-red channels. 
 
Through GLIM we can achieve a resolution of ~ 30 nm along the Golgi axis under 
standard conditions. Importantly, it provides a systematical method to quantitatively map 
any Golgi protein. GLIM can be performed by conventional microscopes, such as wide-
field or confocal microscopes, using common fluorescence labeling protocols. The 
imaging and data processing can take as short as an hour. Through GLIM, we have 
directly demonstrated the progressive transition of the secretory cargo from the cis- to 
trans-side of the Golgi7. 
 
PROTOCOL:  
 
Note: Below is a step-by-step protocol of GLIM for determining the LQ of EGFP-tagged 
tyrosylprotein sulfotransferase 1 (TPST1), a Golgi resident enzyme, in HeLa cells. 
 
1 Preparation of Fluorescence-labeled Golgi Mini-stacks 
 
1.1 Prepare glass coverslips 
 
1.1.1 Aliquot 0.3 mL sterile Dulbecco Modified Eagle's Medium (DMEM) to a well of a 
24-well plate in a tissue culture hood. 
 

1.1.2 Wipe a piece of  12 mm No.1.5 glass coverslip using soft tissue paper dabbed 
with 70% ethanol to remove debris on the surface of the glass coverslip. Use a pair of 
sharp tweezers to briefly soak the coverslip in 70% ethanol, transfer it into the 24-well 
plate and sink it to the bottom of the well containing sterile DMEM.  
 
Note: Glass coverslips are conventionally sterilized by flaming. However, coverslips 
under such treatment easily crack during subsequently handling. 70% ethanol soaking 
is effective in sterilizing glass coverslips without damaging them. 
 
1.1.3 With the lid covered, leave the 24-well plate in the 37 °C CO2 incubator until use.  
 
1.2 Seed cells 
 



1.2.1 Culture HeLa cells (hereafter cells) in a T-25 flask in DMEM supplemented with 
10% Fetal Bovine Serum (FBS) (hereafter complete medium) in a 37 °C CO2 incubator 
supplied with 5% CO2. Antibiotics are not necessary here. 
 
1.2.2 When cells reach ~ 80% confluency, aspirate the culture medium. Add 1 mL of 
0.25% Trypsin-EDTA into the flask and incubate the cells in a 37 °C CO2 incubator for 2 
min. Add 1 mL complete medium into the flask and gently flush the cells off the flask 
wall by pipetting. 
 
1.2.3 Transfer detached cells to a sterile centrifugation tube and spin at 500 x g for 2 
min to pellet the cells. Aspirate the supernatant and suspend the cell pellet in 1 mL 
complete medium. 
 
1.2.4 Aspirate the medium in the well of 24-well plate containing the sterilized glass 
coverslip and seed ~ 1 x 105 cells in the well. Top up the volume of the well with 
complete medium to 0.5 mL. Incubate in a 37 °C CO2 incubator supplied with 5% CO2. 
Culture the cells to ~ 80% confluency.   
 
1.3 Transfect cells 
 
Note: Well-spread cells are advantageous for imaging dispersed Golgi mini-stacks. 
 
1.3.1 Transfect ~ 80% confluent cells with 80 ng GalT-mCherry7 and 320 ng TPST1-
EGFP (see Table of Materials) DNA plasmids using a transfection reagent according to 
the protocol provided by the manufacturer. Incubate in a 37 °C CO2 incubator. Change 
the medium after 4–6 h incubation. The cells are ready ~ 12 h later. 
 
1.4 Nocodazole treatment to generate Golgi mini-stacks 
 
1.4.1 Prepare a nocodazole stock solution (33 mM) by dissolving 10 mg nocodazole 
powder in 1 mL dimethyl sulfoxide. Aliquot the stock solution and store at -20 °C for long 
term storage. 
 
1.4.2 Dilute 1 µL of nocodazole stock solution (33 mM) in 1 mL 37 °C complete 
medium (final concentration 33 µM). Centrifuge at top speed to remove particulate 
matter. 
 
1.4.3 Aspirate the medium in the well and add 0.5 mL of 33 µM nocodazole containing 
complete medium. Incubate the cells in a 37 °C CO2 incubator for 3 h. Proceed to 
immunofluorescence labeling (section 1.5). 
 
1.5 Immunofluorescence labeling  
 
Note: Keep cells in the dark to avoid photobleaching of GalT-mCherry and TPST1-
EGFP. 
 



1.5.1. Prepare reagents for immunofluorescence labeling 
 
1.5.1.1. To prepare 4% paraformaldehyde solution, dissolve 4% (w/v) 
paraformaldehyde powder in hot 1X phosphate buffered saline (PBS) and filter the 
solution through 0.45 µm filter. The solution can be stored at -20 °C.  
 
CAUTION: Paraformaldehyde is toxic and carcinogenic and it can cause skin irritation. 
Wear the appropriate personal protective equipment (PPE). 
 
1.5.1.2. To prepare fluorescence dilution buffer (FDB), mix 5% (v/v) FBS, and 2% 
(w/v) bovine serum albumin (BSA) in 1X PBS. Filter the solution through 0.45 µm filter 
and store the solution at -20 °C. 
 
1.5.1.3. Dissolve 5.35 g NH4Cl powder in 1 L water to prepare 100 mM NH4Cl and 
store the solution at room temperature. 
 
1.5.1.4. Dissolve 10% (w/v) saponin powder in water to prepare 10% saponin, and 
aliquot and store the solution at -20 °C. 
 
1.5.2. Fixation 
 
1.5.2.1. Rinse the well once with 0.5 mL 1X PBS solution and add 0.5 mL 4% 
paraformaldehyde solution. Incubate for 20 min at room temperature. Rinse the well 
twice with 0.5 mL 1X PBS and twice with 0.5 mL 100 mM NH4Cl. Rinse the well twice 
with 0.5 mL 1X PBS. Cells can be kept in 1X PBS at 4 °C overnight in the dark. 
 
1.5.3. Fluorescence labeling 
 
1.5.3.1 Dilute 1 µL mouse anti-GM130 primary antibody in 500 µL FDB containing 
0.1% saponin. Reverse the lid of the 24-well plate and apply 10 µL primary antibody 
mixture onto the lid. 
 
1.5.3.2 Use a pair of sharp tweezers to extract and transfer the glass coverslip 
onto the drop of antibody mixture ensuring that the cell side is in contact with the 
mixture. Incubate the cells with the primary antibody mixture for 1 h at room 
temperature.  
 
Note: The lid with the coverslip can be placed in a humidified plastic bag in the dark. 
 
1.5.3.3 Use a pair of sharp tweezers to extract and transfer the coverslip to the 
well with the cell side up and rinse it in 0.5 mL 1X PBS for three times in ≥ 30 min. 
Shaking is unnecessary. 
 
1.5.3.4 Dilute 1 µL far-red fluorophore conjugated goat anti-mouse IgG 
(secondary antibody) in 500 µL FDB containing 0.1% saponin. 
 



1.5.3.5 Wash and clean the reverse surface of the lid of the 24-well plate. Apply 
10 µL far-red secondary antibody mixture onto the lid. Repeat steps 1.5.3.2–1.5.3.3. 
 
1.5.4. Mounting 
 
1.5.4.1. Prepare the mounting medium by mixing 1 g glycerol, 2.2 g poly(vinyl 
alcohol) (MW ~ 31,000 Da), 1.2 mL 1 M Tris (pH 8) and 8.8 mL H2O. Dissolve the 
mixture in a 60 °C water bath with occasionally vortexing. Store the solution at -20 °C. 
 
1.5.4.2. Thaw the mounting medium and transfer 10 μL onto a glass slide. Overlay 
the coverslip (cell side down) onto the drop of mounting medium. Incubate the glass 
slide at 37 °C for 30 min or room temperature for 1 h to harden the mounting medium. 
Seal the coverslip with colorless-nail polish and store the glass slide at -20 °C. 
 
2. Preparation of Fluorescent Beads for Chromatic-shift Correction 
 
2.1 Coverslip cleaning 
 

2.1.1 Carefully place a piece of  25 mm No.1.5 glass coverslip onto a plastic rack. 
 
2.1.2 Transfer the rack with the coverslip to a 400 mL beaker filled with 300 mL 1 M 
NaOH and sonicate in a bath sonicator (35 Watts) for 15 min. Briefly rinse the rack in a 
400 mL beaker filled with 300 mL deionized water. Transfer the rack to a 400 mL beaker 
filled with 300 mL 99% ethanol and sonicate in the bath sonicator for 15 min. Briefly 
rinse the rack in a 400 mL beaker filled with 300 mL deionized water. 
 
2.1.3 Repeat step 2.1.2 two more times. 
 
2.1.4 Rinse the rack with the coverslip in 300 mL deionized water in a 400 mL beaker 
for 10 min. Repeat the step two more times. Transfer the rack to a 60 °C oven and dry 
the coverslip for 1 h. Store the dried coverslip in a dust-free Petri dish. 
 
2.2  Immobilization of fluorescent beads on the glass coverslip 
 
2.2.1. Dilute 110 nm multi-color fluorescent beads 80-fold in 1X PBS containing 0.1 
μg/μL BSA. Briefly vortex the tube to disperse bead aggregates. Spread 60 μL diluted 

beads onto the cleaned  25 mm No.1.5 glass coverslip (see section 2.1) using a 
pipette tip. Dry the coverslip in a desiccator connected to a vacuum pump in the dark 
and mount the coverslip onto a glass slide in 50 µL mounting medium (see step 1.5.4.2). 
 
3. Image Acquisition 
 
Note: GLIM requires images of high signal-to-noise ratio (SNR) for high precision center 
of mass calculation. The image can be acquired by conventional microscopes such as 
the laser scanning confocal, spinning disk confocal or wide-field microscope. A wide-
field microscope equipped with plan-apochromatic objective lenses and a low noise 



image sensor, such as a charge-coupled device (CCD) and scientific complementary 
metal-oxide semiconductor (sCMOS) can be used. Parameters for the image sensor are 
adjusted to ensure a low read-noise and high dynamic range. The microscope must be 
equipped with the optimal configuration of fluorescence filters for green, mCherry and 
far-red fluorophore, and it must have negligible fluorescence cross-talk. Ideally, the 
imaging system achieves a Nyquist sampling rate in the x, y and z axis, which typically 
requires the x, y and z size of a voxel to be less than 100, 100 and 200 nm, respectively. 
The x and y size of the voxel are always equal and are referred to as pixel_size. The 
pixel_size can be calculated by dividing the camera sensor size by the system 
magnification.  
 
3.1. Image multi-color beads 
 
3.1.1. Image multi-color beads in green, red and far-red channels at the beginning and 
at the end of every imaging session. 
 
Note: Here, images were acquired through a conventional wide-field epi-fluorescence 
microscope (inverted) equipped with 100X NA 1.4 plan-apochromatic objective, 
motorized stage, 200 Watt metal-halide light source and 16-bit sCMOS camera. The 
wavelengths for excitation filter (band pass), dichroic mirror (long pass) and emission 
filter (band pass) of the green channel filter cube are 465–495, 505 and 515–555 nm; 
those for the red channel filter cube are 528–553, 565 and 578–633 nm; and those for 
the far-red channel filter cube are 590–650, 660 and 663–738 nm. During acquisition, 
the size of a voxel along the x, y and z axis is 64, 64 and 200 nm, respectively. 
 
3.1.2. Find a field of view with good bead density. 
 
3.1.3. Acquire 3D image stacks in green, red and far-red channels (channelG, channelR, 
channelB, respectively). Take 3 sections above and below the best focal plane (7 
sections per stack). Save the three stacks as three TIFF files. 
 
Note: The exposure time for each channel is empirically determined to maximize the 
dynamic range, avoid pixel saturation and minimize photobleaching. Other parameters, 
such as filters and the x, y and z size of the voxel, are chosen as discussed above. 
 
3.2. Image Golgi mini-stacks 
 
3.2.1. Use TPST1-EGFP and GalT-mCherry transfected and fluorescently labeled 
(section 1.5) slides to find cells that express TPST1-EGFP and a low or medium level of 
GalT-mCherry. Acquire 3D image stacks as described in step 3.1.3. 
 
4. Image Analysis 
 
4.1. Acquire centers of fluorescent beads 
 



4.1.1. In ImageJ, open a set of bead images consisting of three TIFF files 
(File>Image>Open). 
 
4.1.2. Average 3 consecutive sections around the best focused section in channelR by 
Image>Stacks>Z Project. Input the section number of “Start slice” and “Stop slice”, and 
among options of “projection type”, select “Average Intensity”. 
 
4.1.3. Draw regions of interest (ROIs) that contain no beads in the image using 
“Polygon selections”. In “Analyze>Set Measurements”, check only “Mean gray value” 
and “Standard deviation”. Then execute “Analyze>Measure” to obtain the mean and SD 
of the ROI. 
 
4.1.4. Calculate the background intensity as “mean+6×SD”. Subtract the image with the 
corresponding background intensity values by “Process>Math>Subtract”, input the 
background intensity value corresponding to this channel. 
 
4.1.5. Repeat steps 4.1.2 to 4.1.4 for channelG and channelB image stacks by using the 
same start and stop slice and the same background ROI. Note that the ROI used in step 
4.1.3 can be copied to channelG and channelB images. 

 
4.1.6. Merge the three background-subtracted images (Image>Color>Merge Channels) 
by selecting channelR as red, channelG as green and channelB as blue. A single 
composite image consisting of three channels will be obtained. 
 
4.1.7. Launch ROI manager (Analyze>Tools>ROI Manager). Draw a square ROI 
around single beads ensuring that there is only one bead within each ROI. Add the ROI 
to ROI manager by pressing “t” on the keyboard. Repeat this process and add as many 
ROIs as possible. 
 
4.1.8. In “Analyze>Set Measurements”, check only “Center of mass”.  
 
4.1.9. Select channelR, in ROI Manager, click “Measure” to obtain centers; two columns 
corresponding to the x and y coordinate of centers of ROIs will be displayed in the 
“Result” window. Copy and paste the two columns into a spreadsheet. 
 
4.1.10. Repeat step 4.1.9 for channelG and channelB. 
 
4.1.11. Arrange coordinates of centers in a single spreadsheet in the following 
order: xR, yR, xG, yG, xB, and yB. Save the spreadsheet in “.csv” format as “beads.csv”. 
Leave no space in the file name. 
 
4.2. Select and measure Golgi mini-stacks 
 
4.2.1. Install two macros (attached in Supplemental Materials) in ImageJ, “Macro-
Golgi ROI inspection” and “Macro-Output 3 channels data” by Plugins>Macros>Install”. 
Clear ROI manager and Result window. 



 
4.2.2. Open a set of Golgi mini-stack images consisting of three TIFF files 
(File>Image>Open). 
 
4.2.3. Repeat steps 4.1.2–4.1.5 and save the three background-subtracted images for 
later use. Record the background SDs for channelR, channelG and channelB as SDR, 
SDG and SDB, respectively, for later use. 
 
4.2.4. Duplicate the three background-subtracted images generated from step 4.2.3 
(Ctrl+Shift+D). 
 
4.2.5. In “Process>Image Calculator”, first add the background-subtracted channelG to 
channelR images. Add the resulting image to the background-subtracted channelB 
image. To the resulting image, in “Image>Adjust>Threshold”, select “set” to input “1” as 
“Lowest Threshold Level”. After pressing “Apply”, a black and white binary image is 
resulted.  
 
4.2.6. In “Analyze>Analyze particles”, input the size range for “Size (pixel^2)”. Input “50-
infinity”. Check “Excludes on edges” and “Add to Manager”. ROIs containing Golgi mini-
stacks are now added to the ROI manager.  
 
Note: The size range must be empirically determined to exclude noises which are 
generally small. 
 
4.2.7. Merge the three background-subtracted images (Image>Color>Merge Channels) 
from step 4.2.3 by selecting channelR as red, channelG as green and channelB as blue. 
A single composite image consisting of three channels is generated. 
 
4.2.8. Run the macro “Macro-Golgi ROI inspection” by selecting “Plugins> Macro-Golgi 
ROI inspection”. In the interactive dialog box, visually inspect each ROI to keep or reject 
it. Select ROIs that contain a single object in all three channels.  
 
Note: After running this tool, rejected ROIs are eliminated from the ROI manger. 
 
4.2.9. Check only “Area”, “Mean gray value” and “Center of mass” in “Analyze>Set 
Measurements”. Acquire data by launching the macro tool “Macro-Output 3 channels 
data” (Plugins> Macro-Output 3 channels data).  
 
Note: Areas, Mean intensities, and centers (x and y) of ROIs in channelR, channelG and 
channelB are displayed in the “Result” window. 
 
4.2.10. Copy x and y coordinates of centers into a spreadsheet and arrange them 
in the following order: xR, yR, xG, yG, xB, and yB. Save the spreadsheet as a “.csv” file 
(ministacks.csv). Leave no space in the file name. Proceed to chromatic-shift correction 
of the centers (section 4.3) and LQ calculation (section 4.4). 
 



4.3. Chromatic-shift correction of centers 
 
4.3.1. Install Matlab Compiler Runtime (MCR). 
 
4.3.2. Install the following files in a dedicated working folder: my_train.exe and 
my_test.exe. Copy and paste “beads.csv” and “ministacks.csv” files in the same folder. 
 
4.3.3. Launch “Command Prompt” of Windows and go to the working folder by typing 
the following command “cd path_of_working_folder”. 
 
4.3.4. Generate a chromatic-shift calibration file by using centers of beads. Type the 
following command “my_train.exe beads.csv calibration.mat 1”. A file named 
“calibration.mat” is created in the working folder. Ignore other files that are generated. 
 
4.3.5. Correct the chromatic-shift of centers of Golgi mini-stacks by typing the following 
command “my_test.exe ministacks.csv corrected_ministacks.csv calibration.mat 1”.  
 
Note: A file named “corrected_ministacks.csv” is created in the working folder. It 
contains chromatic-shift corrected coordinates of centers, which are arranged in the 
order of xG, yG, xB and yB. Ignore other files that are created. Take note that the red 
channel is defined as free of chromatic aberration and therefore xR and yR are the same 
as raw data. 
 
4.4. Calculation of LQs 
 
4.4.1. Launch the data analysis software and copy and paste, in the below sequence, 
mean gray values, areas, background SDs obtained from step 4.2.3 (place them at row 
1) and chromatic-shift corrected x and y coordinates of Golgi mini-stacks in channelR 
into a worksheet as columns A to E. Similarly, transfer corresponding data for channelG 
and channelB to columns F to J and K to O, respectively. 
 
4.4.2. Add eight new columns P to W, named “integrated intensity of channel R”, 
“integrated intensity of channel G”, “integrated intensity of channel B”, d1, dx, ABS(tan 
a), ABS(tan b) and LQ.  
 
4.4.2.1. Right click the top of the respective column and select “Set Column Values” to 

calculate values of each column. For column P, input “Col(A)Col(B)”; for column Q, 

input “Col(F)Col(G)”; for column R, input “Col(K)Col(L)”; for column S, input 
“pixel_size*Distance(Col(D), Col(E), Col(N), Col(O))” where “pixel_size” is the size of 
the pixel in nm; for column T, input “pixel_size*((Distance(Col(I), Col(J), Col(N), 
Col(O))^2+Distance(Col(D), Col(E), Col(N), Col(O))^2-Distance(Col(D), Col(E), Col(I), 

Col(J))^2)/(2Distance(Col(D), Col(E), Col(N), Col(O))))”; for column U, input 
“Abs(Tan(Acos((Distance(Col(I), Col(J), Col(N), Col(O))^2+Distance(Col(D), Col(E), 

Col(N), Col(O))^2-Distance(Col(D), Col(E), Col(I), Col(J))^2)/(2 Distance(Col(I), Col(J), 

Col(N), Col(O))Distance(Col(D), Col(E), Col(N), Col(O))))))”; for column V, input 
“Abs(Tan(Acos((Distance(Col(D), Col(E), Col(I), Col(J))^2+Distance(Col(D), Col(E), 



Col(N), Col(O))^2-Distance(Col(I), Col(J), Col(N), Col(O))^2)/(2 Distance(Col(D), 

Col(E), Col(I), Col(J))Distance(Col(D), Col(E), Col(N), Col(O))))))”; for column W, input 
“Col(T)/Col(S)”. 
 
4.4.3. Filter the Golgi mini-stacks by the three criteria described in the Introduction.  
 
4.4.3.1. In the data analysis software, go to “Worksheet>Worksheet Query” and select 
column variables for “If” test. Assign the following aliases I1, I2, I3, d1, A and B for 
columns “integrated intensity of channel R”, “integrated intensity of channel G”, 
“integrated intensity of channel B”, d1, ABS(tan a) and ABS(tan b), respectively. In the 

“If condition” box, input “I1>=30cell(1,3) AND I2>=30cell(1,8) AND I3>=30cell(1,13) 
AND d1>=70 AND (A<=0.3 or B<=0.3)”.  
 
4.4.3.2. Select “Extract to New Worksheet”, click “Apply”. Columns A–W of analyzable 
Golgi mini-stacks are extracted to a new worksheet. 
 
4.4.4. In the new worksheet, right click the top of column W, select “Statistics on 
Column>Open Dialog”. Check “N total”, “Mean”, “SE of mean”, “Histograms”. The 
statistical analysis of LQs is then displayed. 
 
REPRESENTATIVE RESULTS: 
The modern research grade light microscope equipped with a plan apochromatic lens, 
such as the one used in our lab, shows minimal chromatic aberration (Figure 2A). 
However, a careful examination of the multi-color fluorescent bead image can reveal the 
shift of different color images of the same bead (Figure 2B). We define that the red 
channel is free of chromatic aberration and therefore centers of red fluorescence are the 
true positions of beads. The relative chromatic-shifts of green and far-red fluorescence 
can be represented by green and blue vectors originating from the center of red 
fluorescence (Figure 2C). The chromatic-shift within the imaging-plane is empirically 
illustrated by the green and blue vector for each bead (Figure 2D). For our microscope, 
the chromatic-shifts are not uniform as both magnitudes and directions of shifts change 
according to x and y positions. The chromatic-shift can significantly affect the accuracy 
of GLIM as the shift of far-red centers can be as much as 50 nm. Therefore chromatic-
shift must be corrected. Once centers of beads are acquired, we employ first-order 
polynomial fitting to calibrate and subsequently correct the chromatic-shifts of centers. 
The chromatic-shift aberration is greatly improved by this approach (Figure2 D–G). 
 
In mammalian cells, the Golgi complex is aggregated at the perinuclear area which is 
usually not resolvable under a conventional optical microscope (Figure 3A). After 
nocodazole treatment for 3 hours, the perinuclear Golgi complex disappears and 
dozens of Golgi mini-stacks assemble at the endoplasmic reticulum exit sites 
throughout the cytoplasm (Figure 3B). Large chunks of Golgi membrane and 
aggregated Golgi mini-stacks are present and they are not selected for analysis. An 
example image illustrating the selection of Golgi mini-stacks is shown in Figure 3C. 
Using the “Macro-Golgi ROI inspection” tool, 40 selected Golgi mini-stacks are listed in 
Figure 3D. After applying the three criteria, 21 Golgi mini-stacks were analyzable and 



chosen for the calculation of LQs of TPST1-EGFP (Figure 3D; labeled as “L”), with their 
statistics shown in Figure 3E. In total, 111 analyzable Golgi mini-stacks were selected 

from 12 cells and the LQ of TPST1-EGFP was measured to be 0.76  0.04 (mean ± 
SEM; n = 111) (Figure 3F). The LQ of TPST1-EGFP positions it between giantin (LQ = 
0.59) and EGFP-Rab6 (LQ = 1.04)7. It is near GS15 (LQ = 0.83) and ST6GalT1-
AcGFP1 (LQ = 0.82). We have defined the sub-Golgi regions according to LQs by 
considering qualitative localization data from literature: the ERES/ERGIC, < -0.25; cis, 
0.00 ± 0.25; medial, 0.50 ± 0.25; trans-Golgi, 1.00 ± 0.25 and TGN, 1.25–2.00. The LQ 
of TPST1-EGFP therefore indicates its trans-Golgi localization, which is in agreement 
with a previous study14. 
 
FIGURE LEGENDS: 
Figure 1. Schematic illustrations showing variables used in the calculation of 
GLIM. (A) xz view of a Golgi mini-stack that has co-axial centers of GM130, GalT-
mCherry and protein x fluorescence showing Golgi axis, axial angle, dx and d1. The 
image of the Golgi mini-stack is its projection onto the image plane. (B) xy view of a 
Golgi mini-stack with off-axis center of protein x showing angle α, angle β and projection 
axial distance dx. A and B are adapted from Figure 1E and 1F of our previous 
publication7, respectively. 
 
Figure 2. Correction of the chromatic-shift. (A) The three-color merged image of 110 
nm multi-color beads acquired by a wide-field microscope. Each bead emits green, red, 
and far-red (artificially colored as blue) fluorescence. Scale bar, 10 µm. (B) Enlarged 
view of a merged single-bead image with a noticeable chromatic-shift. Scale bar, 200 
nm. (C) A schematic diagram showing that shifts of green and far-red bead images can 
be represented by vectors from the center of the red bead image (0,0) to centers of 
green (green vector) and far-red (blue vector) bead images, respectively. (D, E) The 
effect of the chromatic-shift correction. Within the same field of image, green and blue 
vectors are plotted before and after shift correction. To visualize the tiny shift, the 
magnitude of each vector is amplified 200-fold. (F, G) Scatter plots showing centers of 
green (green dots) and far-red (blue dots) beads before and after shift correction. 
 
Figure 3. A typical example of GLIM, here acquiring the LQ of TPST1-EGFP. A 
HeLa cell expressing TPST1-EGFP (green) and GalT-mCherry (red) were stained for 
endogenous GM130 (blue). (A) A typical cell. (B, C, D, E) A cell treated with nocodazole 
was imaged (B). From the image, analyzable Golgi mini-stacks were selected as shown 
in C. Selected Golgi mini-stacks are labeled by identification numbers. Images of these 
masked Golgi mini-stacks are displayed below in D with their identification numbers. “L” 
denotes that the Golgi mini-stack is valid for the calculation of the LQ (analyzable Golgi 
mini-stacks). Histogram of LQs of 21 mini-stacks from the cell is shown in E. (F) 
Histogram of LQs of 111 mini-stacks from 12 cells. The value shown in the histogram is 
mean ± SEM. 
 
SUPPLEMENTAL MATERIALS: Macro-Golgi ROI inspection.ijm, Macro-Output 3 
channels data.ijm, Matlab codes, My_train.exe, My_test.exe, and Spreadsheet 
template.opj. 



 
DISCUSSION: 
Previously, the localization of a Golgi protein under the light microscopy was mainly 
quantified by the degree of correlation or overlapping of the image of the protein with 
the image of a Golgi marker of known localization15-17. The resulting correlation or 
overlapping coefficient reflects how close the testing protein is to the Golgi marker 
spatially. There are at least three caveats for this approach. First, the correlation or 
overlapping coefficient is nonlinear and it does not directly indicate spatial distance. 
Second, the degree of correlation is critically dependent on the resolution of the 
microscopic system. Therefore, the coefficient between two Golgi proteins is not a 
system-independent constant. Third, two Golgi proteins with the same axial localization 
but different lateral distribution along cisternae can have distinct coefficients. Hence, the 
correlation or overlapping coefficient does not indicate the axial localization of a Golgi 
protein. In an alternative method proposed by Dejgaard et al., cis, trans-Golgi markers 
and the protein of interest are triple-labeled in nocodazole treated Golgi mini-stacks, 
similar to GLIM. Within each Golgi mini-stack, positions of the three maximum intensity 
pixels are acquired and the relative position of the test protein is calculated as a 
distance ratio18. However, their method is unable to achieve sub-pixel resolution, which 
greatly limits its application. Compared to previous quantitative methods, GLIM, which 
was independently developed but bears a similar concept to that of Dejgaard et al., is 
able to quantify the axial localization of a Golgi protein with unprecedented accuracy 
and consistency. 
 
We presented the protocol of GLIM to acquire the LQ of exogenously expressed GFP-
tagged protein — TPST1-EGFP. The LQ of endogenous protein can be determined if its 
antibody is available. Depending on the species of the primary antibody, mouse or 
rabbit, then a rabbit or mouse anti-GM130 antibody, respectively, can be used in the 
triple-labeling protocol. Both rabbit and mouse anti-GM130 antibodies for 
immunofluorescence labeling are commercially available. We have previously 
demonstrated that rabbit and mouse anti-GM130 antibodies give the same results in 
GLIM7. If the test protein is intrinsically red in fluorescence emission, such as mCherry 
fusion, a GFP-tagged Golgi marker protein with known LQ in combination with GM130 
antibody labeling can be used to triple-label cells and indirectly deduce the LQ of the 
test protein. Assuming the marker protein’s LQ is LQm and the distance from the center 
of the marker protein to that of GM130 is dm, the LQ of the test protein x can be 
calculated as (dx/dm)×LQm. One of the greatest advantages of GLIM in comparison to 
super-resolution microscopy is that it can easily be applied to the live cell imaging in 
conventional microscopic setups. We have tried a combination of three fluorescence 
proteins, GFP-Golgin84, mCherry-GM130 and GalT-iRFP670, for dynamically 
monitoring the LQ of GFP-Golgin84 in single Golgi mini-stacks7. 
 
In GLIM, the most time-consuming step is the post-acquisition analysis, especially on 
the selection of analyzable Golgi mini-stacks. As Golgi mini-stacks are heterogeneous 
in both size and molecular composition19, it is unclear if the distribution of LQs (Figure 
3F) represents the heterogeneous architecture of Golgi mini-stacks or the uncertainty of 
our calculation of the LQ. Regardless of the causes, we found that it is important to 



have a large number of analyzable Golgi mini-stacks (n) to ensure the accuracy of the 
LQ, which is compromised when n is small. Typically, data with n ≥ 100 from multiple 
cells yields reliable LQs. Therefore, GLIM gives ensemble-averaged localization data, 
obscuring the individuality of Golgi mini-stacks. Another limitation of GLIM is that it 
assumes that all Golgi proteins have a narrow distribution around a single center. Some 
Golgi proteins, such as COPI subunits, ARF1 and soluble N-ethylmaleimide-sensitive 
factor attachment protein receptor (SNAREs)20,21, have been reported to distribute 
broadly from the cis to the trans-Golgi and the TGN. It is probably inappropriate to study 
their Golgi localization by the LQ. As GLIM currently involves manual selection of the 
Golgi mini-stacks, which is both laborious and subjective, the future development of 
GLIM will be to implement a software tool to automatically select Golgi mini-stacks with 
minimal human interference. 
 
What is the spatial resolution of GLIM? Since the LQ is a ratio, which is unitless, it does 
not indicate a spatial distance. Here, we attempt to give a very rough estimation. The 
spatial resolution of GLIM can be defined as the smallest axial distance between two 
resolvable Golgi proteins. Examining LQs of various Golgi proteins7, we found that 
SEMs of datasets with n ≥ 100 range around 0.03. Assuming two Golgi proteins have 
the same n = 100 and SEM = 0.03, the two Golgi proteins have significant different 
localization by t-test (p < 0.05), i.e., resolvable, if the difference between their LQs is ≥ 3 
× SEM = 0.09. From the EM data, we can estimate that the axial length of the Golgi 
mini-stack, which is also the distance from GM130 to GalT-mCherry in GLIM, is ~ 300 

nm8. Hence, the resolution of GLIM is estimated to be 0.09 × 300  30 nm along the 
Golgi axis. In GLIM, a larger n generally yields smaller SEM, which in turn results in 
higher resolution. 
 
It is probably inappropriate to directly compare the resolution of GLIM to that of the 
immuno-gold EM since the latter technique does not directly yield quantitative 
localization data. Similar to GLIM, the resolution of the immuno-gold EM along the Golgi 
axial can be defined as the smallest distance between two resolvable Golgi markers. To 
measure its resolution requires the study of dual-immuno-gold labeling of two Golgi 
proteins that are closely adjacent to each other along the Golgi axis. Such systemic 
study is probably unavailable according to our knowledge. As discussed in the 
introduction, one of the limiting factors in the spatial resolution of the immuno-gold EM is 
the large size of the antibody complex, which makes the resolution to be worse than ~ 
20 nm. Another important limiting factor of the image resolution is the labeling density of 
antigen molecules. According to the Nyquist sampling theory, there must be at least two 
gold particles per resolution unit. In most immuno-gold EM studies, the distances 
between neighbor gold particles are not < 15 nm due to the very low labeling efficiency; 
this makes it difficult for this technique to achieve an image resolution less than 30 nm. 
From this point of view, we estimate that the resolution of GLIM is at least comparable 
to that of the immuno-gold EM. 
 
GLIM is a robust method that gives highly consistent results. It is independent of the 
type of microscope used. We have tested that wide-field and spinning disk confocal 
microscopes yielded the same results. LQs of the same Golgi proteins acquired at 



different batches of experiments were also in good agreement with each other. A LQ 
database consisting of a diverse range of Golgi resident proteins has been generated 
for comparison and interpretation. We expect that more usage of GLIM in the research 
community will significantly expand the database. Consequently, a more complete 
database quantitatively describing the localization of a large number of Golgi proteins 
will greatly help in understanding the organization and function of the Golgi complex. 
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Name of Material Company Commercial Name Catalog Number Comments/Description

fluorescence beads Invitrogen TetraSpeck beads T7279 As multi-color beads to 

calibrate chromatic-shift 

of the microscope.

Glass coverslip F25 mm (No. 1.5) Menzel

DMEM Capricon DMEM-HPA-P50

Trypsin-EDTA

FBS GE 

Hyclone

SV30160.03

Nocodazole Merck 487928

transfection reagent Invitrogen Lipofectamine 2000 11668-019

transfection medium Invitrogen OptiMEM 31985070

TPST1-EGFP Addgene 66617 A gift from D. Stephens 

(University of Bristol, 

Bristol, United Kingdom)

GalT-mCherry Made in our lab.

paraformaldehyde Merck 1.04005.1000

saponin Sigma-

Aldrich

47036

poly(vinyl alcohol) (Mw ~31,000) CALBIOC

HEM

Mowiol-488 475904

BSA Sigma-

Aldrich

A9647

Mouse anti-GM130 BD 

Bioscience

s

610823 Primary antibody for 

human GM130

Glass coverslip F12 mm (No. 1.5) Menzel CB00120RAC
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http://www.editorialmanager.com/jove/download.aspx?id=616410&guid=d8a7400c-6352-4352-9238-27b6207b47e9&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=616410&guid=d8a7400c-6352-4352-9238-27b6207b47e9&scheme=1


far-red fluorescence conjugated 

goat anti-mouse IgG

Invitrogen Alexa Fluor 647 

conjugated goat anti-

mouse IgG

A-21235 Far red fluorescence 

conjugated secondary 

antibody



Name of Equipment Company Catalog Number

bath sonicator Elma

microscope Olympus IX83

objective Olympus Plan apochromatic, 

100×, NA 1.40

motorized stage Prior Scientific

camera Andor Neo

excitation light Prior Scientific Lumen Pro 200

filter set for green channel Chroma 31001

filter set for red channel Chroma 31002

filter set for far-red channel Chroma 41008

Metamorph software Molecular 

Devices

ImageJ freeware

Microsoft Office Excel 2007 Microsoft

OriginPro8.5 OriginLab

Matlab Compiler Runtime Math works



Comments/Description

Power output: 35 watts

scMOS. Parameters used: 

central quadrant, rolling 

shutter, 200 MHz digitizer and 

16-bit (low noise, high well 

capacity).

200 Watt metal-halide

https://imagej.nih.gov/ij/

https://imagej.nih.gov/ij/#
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ARTICLE AND VIDEO LICENSE AGREEMENT

Title of Article:

Author(s):

Item 1- (check

..Quan!-1!f119|-99a|i-zationof.aGo.|ojprotei1p.y-im-a.g-l1si1:,.-9-eI1"'o|-f-,]gqres.9q19913ss
:

! Hieng Chiong Tie, Bing Chen, Xiuping Sun, Li Cheng and Lei Lu

one box): The Author elects to have the Materials be made available (as described at

2, Backeround. The Author, who is the author of the Article,
in order to ensure the dissemination and protection of the
Article, desires to have the JoVE publish the Article and create
and transmit videos based on the Article, ln furtherance of
such goals, the Parties desire to memorialize in this Agreement
the respective rights ofeach Party in and to the Article and the
Video,

3. Grant of Rishts in Article. ln consideration ofJoVE agreeing
to publish the Article, the Author hereby grants to JoVE,

subject to Sections 4 and 7 below, the exclusive, royalty-free,
perpetual (for the full term of copyright in the Article,
including any extensions thereto) license (a) to publish,
reproduce, distribute, display and store the Article in all forms,
formats and media whether now known or hereafter
developed (including without limitation in print, digital and
electronic form) throughout the world, (b) to translate the
Article into other languages, create adaptations, summaries or
extracts of the Article or other Derivative Works (including,
without limitation, the Video) or Collective Works based on all
or any portion of the Article and exercise all of the rights set
forth in (a) above in such translations, adaptations,
summaries, extracts, Derivative Works or Collective Works and
(c) to license others to do any or all of the above. The
foregoing rights may be exercised in all media and formats,
whether now known or hereafter devised, and include the
right to make such modifications as are technically necessary
to exercise the rights in other media and formats. lf the "Open
Access" box has been checked in ltem 1 above, JoVE and the
Author hereby grant to the public all such rights in the Article
as provided in, but subject to all limitations and requirements
set forth in, the CRC License.

http://www.jove.com/author)via: ffi StanOard Access il Opun Access

Item 2 (check one box):

lX rn. Author is NoT a United States government employee.

ff ,n" Author is a United States government employee and the Materials were prepared in the
course of his or her duties as a United States government employee.

fl rn" Author is a United States government employee but the Materials were NOT prepared in the
course of his or her duties as a United States government employee.

ARTICLE AND VIDEO LICENSE AGREEMENT

1. Defined Terms. As used in this Article and Video License

Agreement, the following terms shall have the following
meanings: "Agreement" means this Article and Video License

Agreement; "Article" means the article specified on the last
page of this Agreement, including any associated materials
such as texts, figures, tables, artwork, abstracts, or summaries
contained therein; "Author" means the author who is a

signatory to this Agreement; "Collective Work" means a work,
such as a periodical issue, anthology or encyclopedia, in which
the Materials in their entirety in unmodified form, along with a
number of other contributions, constituting separate and

independent works in themselves, are assembled into a

collective whole; "CRC License" means the Creative Commons
Attribution-Non Commercial-No Derivs 3.0 Unported
Agreement, the terms and conditions of which can be found
at: http://creativecom mons.org/licenses/by-nc-
nd/3.O/legalcode; "Derivative Work" means a work based
upon the Materials or upon the Materials and other pre-

existing works, such as a translation, musical arrangement,
dramatization, fictionalization, motion picture version, sound
recording, art reproduction, abridgment, condensation, or any
other form in which the Materials may be recast, transformed,
or adapted; "lnstitution" means the institution, listed on the
last page of this Agreement, by which the Author was
employed at the time of the creation of the Materials; "JoVE"
means MyJove Corporation, a Massachusetts corporation and
the publisher of The Journol of Visuolized Experiments;
"Materials" means the Article and / or the Video; "Parties"
means the Author and JoVE; "Video" means any video(s) made
by the Author, alone or in conjunction with any other parties,

or by JoVE or its affiliates or agents, individually or in
collaboration with the Author or any other parties,

incorporating all or any portion of the Article, and in which the
Author may or may not appear,

612542.6
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4. Retention of Rights in A.rticle, Notwithstanding the statute. ln such case, all provisions contained herein that are

exclusive license granted to JoVE in Section 3 above, the not in conflict with such statute shall remain in full force and

Author shall, with respect to the Article, retain the non- effect, and all provisions contained herein that do so conflict

exclusive right to use all or part of the Article for the non- shall be deemed to be amended so as to provide to JoVE the

commercial purpose of giving lectures, presentations or maximum rights permissible within such statute.

teaching classes, and to post a copy of the Article on the

lnstitution's website or the Author's personal website, in each 8. Likeness, Privacv, Personalitv. The Author hereby grants

case provided that a link to the Article on the JoVE website is JoVE the right to use the Author's name, voice, likeness,

provided and notice of JoVE's copyright in the Article is picture, photograph, image, biography and performance in any

included, All non-copyright intellectual property rights in and way, commercial or otherwise, in connection with the

to the Article, such as patent rights, shall remain with the Materials and the sale, promotion and distribution thereof'

Author. The Author hereby waives any and all rights he or she may

have, relating to his or her appearance in the Video or

5. Grant of Riqhts in Video - Standard Access. This Section 5 otherwise relating to the Materials, under all applicable

applies if the "standard Access" box has been checked in ltem privacy, likeness, personality or similar laws.

1 above or if no box has been checked in ltem 1 above. ln

consideration of JoVE agreeing to produce, display or 9. Author Warranties. The Author represents and warrants

otherwise assist with the Video, the Author hereby that the Article is original, that it has not been published, that
acknowledges and agrees that, Subject to Section 7 below, the copyright interest is owned by the Author (or, if more than

JoVE is and shall be the sole and exclusive owner of all rights of one author is listed at the beginning of this Agreement, by

any nature, including, without limitation, all copyrights, in and such authors collectively) and has not been assigned, licensed,

to the Video, To the extent that, by law, the Author is or otherwise transferred to any other party. The Author

deemed, now or at any time in the future, to have any rights represents and warrants that the author(s) listed at the top of

of any nature in or to the Video, the Author hereby disclaims this Agreement are the only authors of the Materials. lf more

all such rights and transfers all such rights to JoVE. than one author is listed at the top of this Agreement and if
any such author has not entered into a separate Article and

6. Grant of Rishts in Video - Open Access. This Section 6 Video License Agreement with JoVE relating to the Materials,

applies only if the "Open Access" box has been checked in the Author represents and warrants that the Author has been

Item 1 above. ln consideration of JoVE agreeing to produce, authorized by each of the other such authors to execute this

display or otherwise assist with the Video, the Author hereby Agreement on his or her behalf and to bind him or her with
grants to JoVE, subject to Section 7 below, the exclusive, respecttothetermsof thisAgreementasif eachof themhad
royalty-free, perpetual (for the full term of copyright in the been a party hereto as an Author. The Author warrants that
Article, including any extensions thereto) license (a) to publish, the use, reproduction, distribution, public or private

reproduce, distribute, display and store the Video in all forms, performance or display, and/or modification of all or any

formats and media whether now known or hereafter portion of the Materials does not and wlll not violate, infringe

developed (including without limitation in print, digital and and/or misappropriate the patent, trademark, intellectual
electronic form) throughout the world, (b) to translate the property or other rights of any third party. The Author
Video into other languages, create adaptations, summaries or represents and warrants that it has and will continue to
extracts of the Video or other Derivative Works or Collective comply with all government, institutional and other
Worksbasedonall oranyportionoftheVideoandexerciseall regulations, including, without limitation all institutional,
of the rights set forth in (a) above in such translations, Iaboratory, hospital, ethical, human and animal treatment,
adaptations, summaries, extracts, Derivative Works or privacy, and all other rules, regulations, laws, procedures or
Collective Works and (c) to license others to do any or all of guidelines, applicable to the Materials, and that all research
the above. The foregoing rights may be exercised in all media involving human and animal subjects has been approved by

and formats, whether now known or hereafter devised, and the Author's relevant institutional review board.
include the right to make such modifications as are technically
necessary to exercise the rights in other media and formats. 10. JoVE Discretion. lf the Author requests the assistance of
For any Video to which this Section 5 is applicable, JoVE and JoVE in producing the Video in the Author's facility, the Author
the Author hereby grant to the public all such rights in the shall ensure that the presence of JoVE employees, agents or
Video as provided in, but subject to all limitations and independent contractors is in accordance with the relevant
requirements setforth in, the CRC License. regulations of the Author's institution. lf more than one

author is listed at the beginning of this Agreement, JoVE may,
7, Government Emplovees. lf the Author is a United States in its sole discretion, elect not take any action with respect to
government employee and the Article was prepared in the the Article until such time as it has received complete,
course of his or her duties as a United States government executed Article and Video License Agreements from each

employee, as indicated in ltem 2 above, and any of the such author. JoVE reserves the right, in its absolute and sole

licenses or grants granted by the Author hereunder exceed the discretion and without giving any reason therefore, to accept
scope of the 17 U.S,C. 403, then the rights granted hereunder or decline any work submitted to JoVE. JoVE and its

shall be limited to the maximum rights permitted under such employees, agents and independent contractors shall have

2
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full, unfettered access to the facilities of the Author or of the
Author's institution as necessary to make the Video, whether
actually published or not. JoVE has sole discretion as to the
method of making and publishing the Materials, including,

without limitation, to all decisions regarding editing, lighting,

filming, timing of publication, if any, length, quality, content
and the like.

11. lndemnification. The Author agrees to indemnify JoVE

and/or its successors and assigns from and against any and all

claims, costs, and expenses, including attorney's fees, arising

out of any breach of any warranty or other representations
contained herein. The Author further agrees to indemnify and

hold harmless JoVE from and against any and all claims, costs,

and expenses, including attorney's fees, resulting from the
breach by the Author of any representation or warranty
contained herein or from allegations or instances of violation
of intellectual property rights, damage to the Author's or the
Author's institution's facilities, fraud, libel, defamation,
research, equipment, experiments, property damage, personal

injury, violations of institutional, laboratory, hospital, ethical,
human and animal treatment, privacy or other rules,

regulations, Iaws, procedures or guidelines, liabilities and

other losses or damages related in any way to the submission

of work to JoVE, making of videos by JoVE, or publication in

JoVE or elsewhere by JoVE. The Author shall be responsible
for, and shall hold JoVE harmless from, damages caused by

lack of sterilization, lack of cleanliness or by contamination
due to the making of a video by JoVE its employees, agents or
independent contractors. All sterilization, cleanliness or
decontamination procedures shall be solely the responsibility
of the Author and shall be undertaken at the Author's

ARTICLE AND VIDEO LICENSE AGREEMENT

expense. All indemnifications provided herein shall include
JoVE's attorney's fees and costs related to said losses or
damages. Such indemnification and holding harmless shall

include such losses or damages incurred by, or in connection
with, acts or omissions of JoVE, its employees, agents or
independent contractors.

12. Fees. To cover the cost incurred for publication, JoVE

must receive payment before production and publication the
Materials. Payment is due in 21 days of invoice. Should the
Materials not be published due to an editorial or production
decision, these funds will be returned to the Author.
Withdrawal by the Author of any submitted Materials after
final peer review approval will result in a US$1,200 fee to
cover pre-production expenses incurred by JoVE. If payment is

not received by the completion of filming, production and
publication of the Materials will be suspended until payment is

received.

L3. Transfer, Governine Law. This Agreement may be

assigned by JoVE and shall inure to the benefits of any of
JoVE's successors and assignees. This Agreement shall be
governed and construed by the internal laws of the
Commonwealth of Massachusetts without giving effect to any
conflict of law provision thereunder. This Agreement may be

executed in counterparts, each of which shall be deemed an

original, but all of which together shall be deemed to me one
and the same agreement. A signed copy of this Agreement
delivered by facsimile, e-mail or other means of electronic
transmission shall be deemed to have the same legal effect as

delivery of an original signed copy of this Agreement.

i
i
i

A signed copy of this document must be sent with all new submissions. Only one Agreement required per submission.

I f"i lq

r School of Biological Sciences
I
I

Name:

Department:

lnstitution:

Article Title:

Signature:

Nanyang Technological University

Date:

Please submit a sisned and dated copy of this license by one of the following three methods:
1) Upload a scanned copy of the document as a pfd on the JoVE submission site;
2) Fax the document to +1.866.381.2236;
3) Mail the document to JoVE / Attn: JoVE Editorial/ 1 Alewife Center #2OO /Cambridge, MA 02139
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We would like to thank the editor and three reviewers for their very constructive comments and 

feedbacks, which have benefited our manuscript tremendously. We believe that our manuscript 

has been further improved and is ready for publishing in JoVE. Please see our replies to the 

editor and reviewers’ comments or suggestions below. 

 

 

Editorial comments: 
The manuscript has been modified by the Science Editor to comply with the JoVE formatting 

standard. Please maintain the current formatting throughout the manuscript. The updated 

manuscript is located in your Editorial Manager account. In the revised PDF submission, there is 

a hyperlink for downloading the .docx file. <b>Please download the .docx file and use this 

updated version for any future revisions</b>. The updated manuscript is also attached. 

  

JoVE is unable to publish manuscripts containing commercial sounding language, including 

trademark or registered trademark symbols (TM/R) and the mention of company brand names 

before an instrument or reagent. Please remove all commercial sounding language from your 

manuscript (text and figures). All commercial products should be sufficiently referenced in the 

table of materials/reagents. Please replace all commercial sounding language in your manuscript 

with generic names that are not company-specific. Examples of commercial sounding language 

in your manuscript are: Opti-MEM, Lipofectamine 2000, Mowiol, Teflon, Excel, OriginPro, etc. 

 

Reply: 

We have modified the manuscript accordingly. 

 

Please ensure that all items mentioned have been included in the Materials/Equipment list, and 

are accompanied by a catalog number. For e.g. Trypsin-EDTA, etc. 

 

Reply: 

We have modified the manuscript accordingly. 

 

Please define all abbreviations before use. For e.g., 3D-SIM, STED, PALM, STORM, DMEM, 

etc. 

 

Reply: 

We have modified the manuscript accordingly. 

 

Please use h for hour(s), min for minute(s) and s for seconds throughout the manuscript 

(including figures and tables). 

 

Reply: 

We have modified the manuscript accordingly. 

 

Please include spaces between all numbers and units. 

 

Reply: 

We have modified the manuscript accordingly. 

Rebuttal Comments Click here to download Rebuttal Comments Editorial
comments.docx

http://www.editorialmanager.com/jove/download.aspx?id=616380&guid=8d88b925-38ec-4ecb-a0b2-8b28271ece15&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=616380&guid=8d88b925-38ec-4ecb-a0b2-8b28271ece15&scheme=1


 

Please include at least six keywords. 

 

Reply: 

6 keywords have been added accordingly. 

 

Please ensure that all text in the protocol section is written in the imperative tense as if you are 

telling someone how to do the technique (i.e. “Do this”, “Measure that” etc.). Avoid usage of 

phrases such as “could be,” “should be,” and “would be” throughout the Protocol. Any text that 

cannot be written in the imperative tense may be added as a “Note”, however, notes should be 

used sparingly and actions should be described in the imperative tense wherever possible. For 

e.g. please re-write steps 1.1.4, 1.2.1, 2.2.3, 3.1.1, etc. in the imperative tense. 

 

Reply: 

We have modified the manuscript accordingly. 

 

1.1.4: Approximately how many hours can the slide be incubated? 

 

Reply: 

We have modified the text. 

 

1.2.1: Are antibiotics added to the medium? 

 

Reply: 

They are not necessary. We have modified the text. 

 

1.3.2: Please provide references/citations for the plasmids. 

 

Reply: 

We have modified the manuscript accordingly. 

 

1.5.1.1:  Please provide a Caution statement for PFA. 

 

Reply: 

A caution statement has been added for PFA. 

 

1.5.3.5: transfer how? 

 

Reply: 

Modified by adding “use a pair of sharp tweezers to extract and transfer..” 

 

Section 3 (image acquisition): Please mention the type of microscope, setting and parameters 

(filters, wavelength, apertures, etc.) used in your studies. If image acquisition is to be filmed, 

please provide stepwise detail on how to acquire image stacks. For steps that involve software, 

please make sure to provide all the details such as “click this”, “select that”, “observe this”, etc. 

Please mention all the steps that are necessary to execute the action item. 



 

Reply: 

We have modified the manuscript accordingly. 

 

3.1.3: Please provide a reference for acquisition. 

 

Reply: 

We have added a note. 

 

3.2.1: Please provide the microscope, setting and parameters for imaging. 

 

Reply: 

It is the same as 3.1.3. 

 

The Note at the beginning of the Image analysis section (section 4) should be moved to section 3 

(image acquisition). 

 

Reply: 

We have modified the text accordingly. 

 

After you have made all of the recommended changes to your protocol (listed above), please re-

evaluate the length of your protocol section. There is a 10-page limit for the protocol text, and a 

3- page limit for filmable content. If your protocol is longer than 3 pages, please highlight (in 

yellow) 2.75 pages or less of text (which includes headings and spaces) to identify which steps 

should be visualized to tell the most cohesive story of your protocol steps. Please see JoVE’s 

instructions for authors for more clarification. Remember that the non-highlighted protocol steps 

will remain in the manuscript and therefore will still be available to the reader. 

 

Reply: 

OK. We have prepared a 3-page video script which is included as a supplementary file. 

 

Visualization and highlighting: Please note that scripting and calculations (e.g. section 4.3, 4.4) 

cannot be filmed. 

 

Reply: 

OK. 

 

If you are re-using figures from a previous publication, please obtain explicit permission to re-

use the figure from the previous publisher (this can be in the form of a letter from an editor or a 

link to the editorial policies that allows you to re-publish the figure). Please upload the text of the 

re-print permission (may be copied and pasted from an email/website) as a Word document to 

the Editorial Manager site in the "Supplemental files (as requested by JoVE)" section. Please 

also cite the figure appropriately in the figure legend, i.e. "This figure has been modified from 

[citation]." 

 

Reply: 



We have supplied the permission document as a supplementary file. Please also see below. 

Molecular Biology of the Cell (MBoC) ©2016 by The American Society for Cell Biology (ASCB). 

Individual articles are distributed by The American Society for Cell Biology under license from the 

author(s), who retain copyright. (http://www.molbiolcell.org/site/misc/terms.xhtml ) 
Please expand your discussion to cover the following in detail and in paragraph form: 1) 

modifications and troubleshooting, 2) limitations of the technique, 3) significance with respect to 

existing methods, 4) future applications and 5) critical steps within the protocol. 

 

Reply: 

We have expanded our discussion to cover these topics. 

 

References: Please abbreviate all journal titles. 

 

Reply: 

We have used JoVE style to format our references in Endnote. 

 

JoVE reference format requires that DOIs are included, when available, for all references listed 

in the article. This is helpful for readers to locate the included references and obtain more 

information. Please note that often DOIs are not listed with PubMed abstracts and as such, may 

not be properly included when citing directly from PubMed. In these cases, please manually 

include DOIs in reference information. 

 

Reply: 

We have used JoVE style to format our references in Endnote. 

 

Please take this opportunity to thoroughly proofread your manuscript to ensure that there are no 

spelling or grammatical errors.  

 

Reply: 

We have tried our best to proofread our manuscript. 

 

 

 

Reviewers' comments: 

Reviewer #1: 
Manuscript Summary: 

The authors show a novel technology to gain high resolution images of the Golgi apparatus. The 

Golgi consists of several subdomains for instance required for cargo import and export. 

However, visualization and quantification of these domains have been difficult because of the 

resolution of conventional light microscopes. The manuscript shows a novel super-resolution 

imaging technique that allows to systematically and quantitatively localize Golgi proteins called 

GLIM (Golgi protein localization by imaging centers of mass). The method can be applied with 

classical Golgi markers and state of the art light microscopy. 

 

Major Concerns: 

N/A 

http://www.molbiolcell.org/site/misc/terms.xhtml


 

Minor Concerns: 

I would discuss the limitation of GLIM in the article discussion not in the abstract. 

The Figures are not labeled as (Figure1, Figure2 etc) 

 

Reply: 

We would like to thank this reviewer for his/her comments. We have removed the limitation 

from the abstract as it is discussed in Discussion. Figures are now labeled. 

 

Additional Comments to Authors: 

N/A 

 

 

Reviewer #2: 
Manuscript Summary: 

It is appreciated that the authors developed a novel method to quantitatively localize proteins to 

Golgi cisternaes. The autors provided the detailed protocols for the method, which should be 

useful for other scientists who work on Golgi associated proteins. The manuscript was well 

written up. 

 

Major Concerns: 

N/A 

 

Minor Concerns: 

1. Are there any other quantitative analysis investigations before? if yes, the author should 

discuss. 

 

Reply: 

We would like to thanks this reviewer for his/her comments. As suggested, a paragraph has been 

added in “Discussion”. 

 

2.In protocol section: for the labeling procedure, the author skipped the permeablization 

step,instead of incubation with antibody in 0.1% saponin, I wonder if this is cell type dependent 

protocol. 

 

Reply: 

We didn’t skip the permeabilization step. 0.1% saponin serves as a mild detergent to 

permeabilize cells. 

 

3.Have the authors used other cell types to verify this protocol? there may have variances in 

different cell types, the authors may give discuss. 

 

Reply: 

We have reported the findings on other cell types in our MBoC paper (Tie et al., 2016). In 

conclusion, Golgi proteins have very similar LQs in various mammalian cells types. 

 



Additional Comments to Authors: 

N/A 

 

 

Reviewer #3: 
Manuscript Summary: 

The Golgi stack plays a central role in the secretory pathway, serving both as a major sorting 

station but also as the site of extensive post-translational processing of glycoproteins and lipids. 

Thus there are many Golgi resident proteins and these typically are found in only a subset of the 

cisternae that make the stack. Determining the precise localization of proteins in the stack is 

challenging as the gap between cisternae is less that the wavelength of light, and immuno-

localization of proteins by electron microscopy is technically very difficult and tends to work 

best with abundant proteins. 

The authors of this paper have recently reported the use of a light microscopy based method in 

which the distribution of a particular protein within the stack is determined relative to two 

reference proteins, and the data from many stacks averaged so that the centre of the distribution 

of localization by light microscopy gives a position within the stack relative to the ends that has a 

better resolution that a single micrograph would allow. This is potentially a very useful method, 

but it also quite involved as it requires specialized image analysis methods. Thus this manuscript 

gives an introduction to the method and the provides a detailed description of how the authors 

have performed the imaging and the image analysis, along with providing some plug-ins for 

ImageJ that help with the analysis. 

Overall the manuscript is clearly written, and seems likely to be of considerable help to any lab 

interested in trying this method. As such it is potentially suitable for publication, although there 

are a few relatively minor issues that would need to be addressed before it is ready to be 

published. 

 

Major Concerns: 

N/A 

 

Minor Concerns: 

a) The figures in the paper are similar to the first three figures in the authors' recent paper that 

reported the development and application of the method (Tie et al (2016) MBoC 27, 848). 

Figures 2 and 3 are different, even if they illustrate the same points, but Figure 1 is identical to 

Figure 1 in Tie et al which might raise issues. 

 

Reply: 

 

We would like to thank this reviewer for very constructive comments and questions, which 

prompt us to think more about our method. 

Please also see above in this rebuttal letter. Yes, Figure 1 is identical to our published articles in 

MBoC. We can do so since, for MBoC articles, the authors retain their copy right. We have 

supplied the permission as a supplementary file. 

 

b) The abstract should state the actual resolution that the method can achieve. 

 



Reply: 

OK. We have stated it in the abstract and it is explained in the newly added paragraph in 

discussion. 

 

c) The introduction refers to Golgi cisternae having a thickness of <100 nm. However, for 

resolution, the key parameter is the distance between the cisternae, and so the authors should 

state this value. 

 

Reply: 

OK. We have modified the corresponding text to “<100 nm in both cisternal thickness and 

distance”. 

 

d) Does the method really produce a resolution comparable to immuno-EM as the authors state? 

This is hard to assess as the actual resolution is not stated. 

 

Reply: 

Yes, we think so. We have discussed the comparison between the two techniques in resolving 

Golgi proteins in the newly modified Discussion. 

 

e) The authors claim that nocodazole-treated Golgi stacks "closely resemble" the normal Golgi. 

However, the authors should mention and cite a recent paper from the Perez lab that indicates 

that some of the mini-stacks are not fully functional for some hours after nocodazole addition 

(Fourriere et al (2016) J. Cell Sci. 129, 3238-50). 

 

Reply: 

OK. We have discussed this point accordingly in the Discussion. 

 

f) In part 1.5.3.3 the authors should describe how they remove the coverslip from the well for 

transfer. 

 

Reply: 

OK. We have modified the text accordingly. 

 

g) The section at the start of section 4, "Image Analysis" describes what sort of microscopes 

should be used and this would be better at the start of Section 3 on Image Acquisition. 

 

Reply: 

OK. We have modified the manuscript accordingly. 

 

h) The authors should discuss the issue of over-exposure of images. Surely it is critical to ensure 

that no part of the Golgi has a maximum intensity - ie that the image does not become saturated. 

Indeed it is a bit disturbing that many of the mini-stacks in Figure 3C and 3D appear white 

suggesting that they have been over-exposed. 

 

Reply: 



As for other quantitative image analysis, intensity-saturated images cannot be used in GLIM. 

The intensities in Figure 3C and D are artificially scaled up so that individual Golgi mini-stacks 

are visible to readers, but they are not saturated. We also added “avoid pixel saturation” in the 

beginning of the Section 3 “Image acquisition”. 

 

j) In section 4.4.2 the authors described a lot of editing that is required in Excel. Would it be 

possible to also provide a template file that already has this editing inserted and which could then 

be downloaded? 

 

Reply: 

OK. In Section 4.4.2, OriginPro but not Excel is used. The OriginPro template is provided as 

suggested. 

 

 

Additional Comments to Authors: 

N/A 
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